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No. Topics  

  1. Introduction to Word Processing & Word Processors 

2. Examples of some popular word processing packages 

3. Uses of word processor 

4. Application of Word Processor 

5. Creating, Editing, Formatting of Documents 

6. File, Edit, View Menus 

7. Full Screen, Zoom, Font, Bullets, Border, paragraph, Change Case, Drop Cap options, 

Search and replacement of text, Print Features 

8. Mail Merge Facility, Auto Text, Spelling checker, 

9. Table creation, deletion, selection and formatting, Picture, word art & drawing toolbar 

facilities 

Reference Books: 

• PC S/W for Windows 98 Made Simple — R K Taxali 

• Step -by -Step Microsoft Word 2007 

 

What is Word Processing? 

Word Processing refers to typing, editing and formatting of any kind of document, which 

could be a letter, memorandum, balance sheet, reports, booklets and so forth. Word 

processing simply processes words i.e., text based information. 

A word processor does this by simply formatting the information you or someone else has 

keyed into the computer. 

The user, who is typing the document, can verify the document that is displayed on the 

computer screen. If the user finds any mistake while typing the document or after finishing 

typing, user can easily correct mistakes. Once the user is sure that there are no mistakes in the 

document, it may be printed. 

You can type any document using the powerful features of the word processor. 

Some Common Word Processing Packages 

The followings are examples of some popular word processor 

available: 

 WordStar  

 Word perfect 

 Microsoft word 

 Open Office Writer 

 

Advantages of Word processing: 

Advantages of using word processing are as follows: 

1. It helps in printing relatively error-free documents in the desired format. 
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2. Any number of copies of the document can be printed without retyping. 

3. Facility of spelling checking and correction, grammar checking and correction, and 

thesaurus helps us to improve our mistakes while writing. 

4. We can get different quality of printouts by using different printing modes or by using 

different printers. 

5. Word processing helps us in preparing such documents through its special features 

such as boldface, underlined, different font and size of characters, centering of text, 

adjustable margins and tabs, etc. 

6. In word processing the previous document can be recalled from the memory, which 

helps in saving time and effort. 

7. Word processing allows to format text i.e. move a block of text, copy text, etc. 

8. You can use various commands to format the document. 

9. You can check on the screen for mistakes and correct them.  

10. You can print any number of copies of the document without retying, and all printouts 

look like the first copy. 

11. It helps the sender to get more business and improve relations with clients. 

12. It helps in preparing such documents through its special features, such as boldface, 

underlined, different font and size of characters, centering of text, adjustable margins and 

tabs, spelling and grammar checking and correction etc. 

13. There are many jobs, such as tender offer, project report, thesis etc., that require many 

revisions to be carried out in the document before printing the final version. 

14. It also allows moving a block of text; say a paragraph for the first page to some other 

page. 

15. We can insert any type of the object from outside of the word. E.g. if you want to 

insert a picture from the paint, you can do it using insert object command 

Features of word processing: 

Features available in word processors are as follows: 

1. Adjustable page size and margins. 

2. Printing selected text in boldface, italic or underlined. 

Printing selected text in superscript or subscript style. 

3. Changing the font and the size of letters of the selected text. 

4. Right justifying paragraphs i.e. the last character of each line is aligned at the right 

margin. 

5. Adjustable line and characters spacing. 

6. Moving selected text to another location within the document or to another document. 

7. Facility to define headers and footers. 

8. Facility to create footnotes and endnotes. 

9. Facility to create multiple-column text. 

10. Index and table of contents generation. 

11. Spelling and grammar checking. 

12. Thesaurus, etc. 
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What is word? 

It is a software program (package) designed by Microsoft Corporation, USA for word 

processing application. It is a very flexible and easy to use word processor. It is one of 

the most popular word processors in the world for the windows platform on IBM and 

compatible PC. It is also available for DOS and Mac operating systems. 

We use Word for Windows 3.11, Windows 95, Windows 98, Windows NT, Windows XP, 

Windows 7 or some other operating system. 

Microsoft Word 

Microsoft Word is a word processing software package. You can use it to type letters, 

reports, and other documents. 

Components of Word 

The Microsoft Word 2007 window appears and your screen looks similar to the one shown 

here. 

 

The Microsoft Office Button 

In the upper-left corner of the Word 2007 window is the Microsoft Office button. When 

you click the button, a menu appears. You can use the menu to create a new file, open an 

existing file, save a file, and perform many other tasks. 

The Quick Access Toolbar 

Next to the Microsoft Office button is the Quick Access toolbar. The Quick Access 

toolbar provides you with access to commands you frequently use. By default, Save, 

Undo, and Redo appear on the Quick Access toolbar. You can use Save - to save your file, 

Undo to rollback an action you have taken, and Redo to reapply an action you have rolled 

back. 
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The Title Bar 

Next to the Quick Access toolbar is the Title bar. The Title bar displays the title of the 

document on which you are currently working. Word names the first new document you 

open Document-1. As you open additional new documents, Word names them 

sequentially. When you save your document, you assign the document a new name.  

 

The Ribbon 

You use commands to tell Microsoft Word what to do. In Microsoft Word 2007 you use 

the Ribbon to issue commands. The Ribbon is located near the top of the screen, below the 

Quick Access toolbar. At the top of the Ribbon are several tabs; clicking a tab displays 

several related command groups. Within each group are related command buttons. You 

click buttons to issue commands or to access menus and dialog boxes. You may also find a 

dialog box launcher in the bottom-right corner of a group. Clicking the dialog box launcher 

gives you access to additional commands via a dialog box. 

 

The Ruler 

The ruler is found below the Ribbon. 

 

You can use the ruler to change the format of your document quickly. If your ruler is not 

visible, follow the steps listed here: 

1. Click the View tab to choose it. 

2. Click the check box next to Ruler in the Show/Hide group. The ruler appears below the 

Ribbon. 

The Text Area 

Just below the ruler is a large area called the text area. You type your document in the text 

area. The blinking vertical line in the upper-left corner of the text area is the cursor. It 

marks the insertion point. As you type, your text displays at the cursor location. The 

horizontal line next to the cursor marks the end of the document. 
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The Vertical and Horizontal and Vertical Scroll Bars 

The vertical and horizontal scroll bars enable you to move up, down, and across your window 

simply by dragging the icon located on the scroll bar. The vertical scroll bar is located along 

the right side of the screen. The horizontal scroll bar is located just above the status bar. To 

move up and down your document, click and drag the vertical scroll bar up and down. To 

move back and forth across your document, click and drag the horizontal scroll bar back and 

forth. You won't see a horizontal scroll bar if the width of your document fits on your screen. 

The Status Bar 

The Status bar appears at the very bottom of your window and provides such information as 

the current page and the number of words in your document. You can change what displays 

on the Status bar by right-clicking on the Status bar and selecting the options you want 

from the Customize Status Bar menu. You click a menu item to select it. You click it again 

to deselect it. A check mark next to an item means it is selected. 

 

Understanding Document Views 

 

In Word 2007, you can display your document in one of five views: Draft, Web Layout, Print 

Layout, Full Screen Reading or Online Layout. 

Draft View: You use Draft view to quickly edit your document.  

Web Layout: Web Layout view enables you to see your document as it would appear in a 

browser such as Internet Explorer. 
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Print Layout: This view is the most frequently used view. The Print Layout view shows the 

document as it will look when it is printed. 

Reading Layout / Full Screen Reading: Reading Layout view formats your screen to make 

reading your document more   comfortable. 

Outline View: Outline view displays the document in outline form. You can display headings 

without the text. If you move a heading, the accompanying text moves with it. 

Working with document windows: 

When you create or open a document in Word, the document opens in a separate window. 

You can quickly switch from one document to another by clicking the document's button on 

the taskbar or by pressing ALT+TAB. You can also view several open Word documents at 

the same time by using the Arrange All command (View menu). 

How to get Word Help? 

Sometimes you may be working on an important document and you forget how to do a 

particular task in Word. In that case, if you do not have your workbook with you, you may be 

stuck. In such situation, just press Fl key Word displays useful help information. If you like 

you can search any help topic in the Word help system. 

New - Opens a new document. If you use the keyboard combination indicated 

on the right a blank document opens immediately. Selecting the New menu item 

with your cursor gives the opportunity to open a large number of types of 

documents. 

Open - Opens a previously saved document. 

Close - Closes the active document but does not quit the application. 

Save - Saves the active document with its current file name, location and format. 

Save As - Saves by opening a window which gives the opportunity to change the file 

name, location or format. 

Page Setup - Sets margins, paper size, orientation and other layout options. 

Print Preview - Shows how the file will look when you print it. 

Print - Prints the active file, also gives the opportunity to change print options 

Exit - Closes Microsoft Word. 

 

How to create a new blank document? 

There are several ways to create a new document. 

1. On the Office Button, click New. 

2. Press the Control and N keys. (i.e. Ctrl + N) 

 

How to open a document on your hard disk or a network? 
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Either 

1. Click Open from the Office Button. 

2. If you want to open a document that was saved in a different folder, locate and open 

the folder. 

3. Click the document you want to open. 

 OR 

1. Press the control and O keys. 

Note: you can open several documents simultaneously. 

 

How to show a list of all open documents? 

Click on the Office button. Under Recent Documents, the list of all last reviewed documents 

will be shown. You can move from one document to another by selecting them from this 

menu bar. 

How to save a new unnamed document? 

2. Click Save on the Office button. OR Press the control and S keys. 

3. If you want to save the document in a different folder, locate and open the folder 

using   save as in option. 

4. In the File name box, type a name for the document. 

5. Click Save. 
 

How to save an existing document? 

1. Click Save icon on the Standard toolbar. 
 

How to save all open documents at the same time? 

1. Click Save All on the Office Button. Word saves all open documents and templates at 

the same time. If any open documents have never been saved, the Save As dialog box 

appears so that you can name them. 
 

How to save a copy of a document? 

1. Open the document you want to make a copy of. 

2. On the Office button, click Save As. If you want to save the document in a different 

folder, locate and open the folder using the save in option. 

3. In the File name box, type a new name for the document. 

4. Click Save. 

 

How to close a document or documents?  

1. On the Office button, click Close. 

 

Selecting a text by dragging a mouse: 

1. Press and hole the mouse button where you want to the selection to begin 
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2. Without releasing the mouse button, drag the mouse in the desired direction. AS 

you drag the mouse, word selects the text. If you end up selecting extra text, you 

can drag the mouse in the opposite direction 

3. After you have selected the desired text, release the mouse button. Note: Similarly 

you can select the text using shift & arrow keys. 

How to select a word: using keyboard? 

1. Put the cursor at the first character of the word to which you want to select. 

2. Press the shift and left arrow key. 

How to select a word using mouse? 

1. Put the cursor on the word to which you want to select. 

2. Double click the left mouse button but at that time the mouse cursor must be there. 

How to select a line using keyboard? 

1. Put the cursor at the first character of the line to which you want to select. 

2. Press the shift and end key. 

How to select a line, using mouse? 

1. Put the cursor at the beginning of the line to which you want to select. 

2. When the cursor changes from line to pointer, click the left mouse button, but at that 

time the mouse cursor must be there. 

What is a paragraph? 

In word, when you start typing in a new document, you enter text in the first paragraph. 

Word does not impose any limit on the size of the paragraph. Paragraph may have any 

number of lines. When you press enter, word ends it and starts a new paragraph. When 

you press the enter key, word inserts a special symbol at the end of paragraph. This special 

symbol is you can see this symbol by pressing this icon form the standard toolbar. 

How to select a paragraph, using keyboard? 

1. Put the cursor at beginning of the paragraph to which you want to select. 

2. Press the shift and down arrow key. 

How to select a paragraph using mouse? 

1. Put the cursor at anywhere within the paragraph to which you want to select. 

2. Triple clicks the left mouse button, but at that time the mouse cursor must be there. 

How to move (cut) or copy texts or any other item(s) for a short distance? 

1. Select the item you want to move or copy. 

2. Do one of the following: 

 To move the item, click Cut icon from the Home ribbon or press directly Ctrl+X 

 To copy the item, click Copy icon from the Home Ribbon or press directly 

Ctrl+C. 
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3. Click where you want the item to Paste. 

4. Click Paste on the Home ribbon. Or Press Ctrl+V. 
 

How to delete a text? 

1. Select the text to which you want to delete and then press the DEL key. 

2. You can delete text by pressing Backspace key as well. (Right to Left) 

3. You can delete text by pressing Delete key as well. (Left to Right) 

Document Formatting 

Change font Style 

1. Select Text 

2. Under Home Tab Select Font Type and select the font from available fonts. 

 

Change font Size 

1. Select Text 

2. Under Home Tab Select Font Size and select the size from available sizes. 

OR 

1. Select Text 

2. Select Shrink and Grow buttons. 
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Bold, Italic and Underline 

 Bold Text: 

1. Select Text 

2. Under Home Tab Click Bold Button.  

OR 

1. Select Text. 

2. Press Ctrl+B keys. 

 

 Italic Text: 

1. Select Text 

2. Under Home Tab Click Italic Button.  

OR 

1. Select Text. 

2. Press Ctrl+I keys. 

 

 Underline Text: 

1. Select Text 

2. Under Home Tab Click Underline Button.  

OR 

1. Select Text. 

2. Press Ctrl+U keys. 

 
 

Paragraph Dialog 

You can create this indent either using Format Paragraph command or form the Ruler Bar. 

Changing Paragraph Margins (Indents) 

1. Put the cursor anywhere in the paragraph and select the paragraph command from 

the Format menu bar. 

2. From the paragraph dialog box select the Indents and Spacing. 

3. From this dialog box you can the select the appropriate alignment from the 

'Alignment' option. 

4. The 'Indentation' box contains two boxes for left & right margins, this you can 

specify the left and right margins values in inches for the selected paragraph. 

Note: you can also set this indent using Ruler Bar. You can increase or decrease this 

indent using increase and decrease indent icon from the formatting toolbar. 

Changing Spacing before and after the Paragraph: 

1. Select the paragraph 

2. From the Home ribbon select the Paragraph command and from it select the Indent 

and Spacing option. 

-a. In Spacing Before and After specify the value. By default the Word measures this 

value in the points. (72 point=l inch). 
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Changing Line Spacing in a paragraph: 

2. Put the cursor within the paragraph 

3. From the Paragraph in Home ribbon click on Line spacing 

4. select the appropriate line spacing option. The Word display the different line spacing 

options like Double, Single, 1.5 lines, At Least, Exactly and Multiple. 

Page Setup: 

The Page Setup dialog box available on the Page Layout ribbon enables you to define the 

page size, margins (top, bottom, left, right, etc.), orientation (portrait or landscape), etc. 

for your document. This helps you to precisely control the appearance of your page. 

Top Margin: The top margin is the margin that Word leaves at the top of the page. This 

margin is specified in inches. By default, Word leaves a margin of 1" at the top of every 

page. The header for your document, that is printed in the top margin. 

Bottom Margin: The bottom margin is the margin that Word leaves at the bottom of every 

page. By default, Word leaves a margin of 1" at the bottom of every page. The bottom 

margin is measured from the bottom edge of the paper. If you define any footer for your 

document, that is printed in this margin. 

Left Margin: The left margin is the margin that Word leaves at the left side of the page. The 

default value of the left margin is 1.25". 

Right Margin: This is the margin that Word leaves at the right side of the page. The default 

value of the right margin is 1.25". 

Header Margin: The header margin is the margin that Word leaves before printing the 

header. By default, the header margin is 0.5". The header margin is measured from the top 

edge of the paper. If you are not using any header in your document, the value of the header 

margin does not affect the layout of the page. 

Footer Margin: The margin that Word leaves after printing the footer is called the footer 

margin. This margin is measured from the bottom edge of the paper. Like the header margin, 

the default value of the footer margin is 0.5". 

Page Size: When you create a new document, Word assigns a default page size based on the 

normal template available in Word. The default page size is usually 11" in length and 8.5" in 

width. 

Gutter Margin: In the Page Setup dialog, box, you find a text box for the gutter margin. The 

gutter margin is also called the binding margin. This margin is used only when you want to 

prepare a document that will be bound and you want to leave a specific margin for binding. 

The default value of the Gutter margins is zero and for printing normal documents, such as 

letters, memoranda, etc., you do not need to use any gutter margin. When define gutter 

margin, Word shows its effect in the Preview box. 

Orientation: There are two types of the orientation. 

a. Portrait: To set up the page vertically 

b. Landscape: To set up the page horizontally 
 

Header or footer: 

 Select the Insert tab. 



Unit-1 BBA-ITM SEM-1 PCSP 

PREMAL SONI                                                                                                      Page 12 

 

 Click either the Header or Footer command. A menu appears with a list of built-in 

options you can use. 

 Left-click one of the built-in options, and it will appear in the document. 

OR 

 Left-click Blank to select it. 

 

 The Design tab with Header and Footer tools is active. 

 
 Type information into the header or footer. 

 

To insert the date or time into a header or footer: 

 With the header or footer section active, click the Date & Time command. 
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 Select a date format in the dialog box that appears. 

 
 Click OK. The date and time now appear in the document. 

Other header and footer options 

There are many other header and footer options you can use to design these sections of your 

document. From the Header and Footer Tools Design tab, you can see all of your design 

options.  

 

 

Separate Header/Footer for Odd and Even Pages: 

In multiple page documents, such as book or report, you might have seen separate headers for 

odd and even pages. Say if you want to give the unit number and name on even pages and 



Unit-1 BBA-ITM SEM-1 PCSP 

PREMAL SONI                                                                                                      Page 14 

 

college name on odd pages at that time you can use this option from the page layout option 

of page setup command. 

 

Separate Header/Footer for first Pages: 

It can help you to insert the heading or footer on the first page which is differ from the all 

other pages heading or footer of the document. If you want to give the unit name and number 

with college name only on first page and on others pages of the document if you want to give 

name & number of unit only then you can use this option. 

Document Views 

 Under View Tab goto Document Views group. 

 Here we can see 5 options for document views 

 

 

Zoom Functionality in Word 

 Under View Tab goto Zoom group. 

 Here we can see different options for zooming of documents. 

 
 We can set the zoom percentage accordingly either by selecting the value or setting it. 

OR 

 In the status bar there is an option for document zoom setting 

 
 We can set the slider value to zoom in or zoom out of the document. 

Font Dialog Box: 
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 The Font Dialog Box allows to set the Font Family, Font Style, Font Size, Font 

Effects, Font Color, Underline Style etc. 
 

Bullets &Numbering 

A BULLET is a dot or other symbol that is placed before text, such as items in a list, to add 

emphasis. Bulleted or numbered lists make your documents more readable and visually 

interesting. 

To insert Bullet or Numbering 

1. Select the items you want to add bullets or numbering to. 

2. On the Home ribbon, click Bullets or Numbering and then select Bullets and  Numbering 

option. 

Borders: 

 In word borders can be applied to either paragraphs or full pages of documents. 

 This can be implemented by Borders Dialog Box. 

 Under Page Layout Ribbon go to Page Background group and select Page Borders 

  
 Here we can set Border Style, Color, Width etc. 
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Change Case: 

 Word allows changing case of words by using built in functionality of Change Case. 

 
 The options available are 

o Sentence Case 

o Lowercase 

o Uppercase 

o Capitalize Each Word 

o Toggle Case 

 

Drop Cap 

 We can set the drop cap effect means a big capital character in the beginning of the 

paragraph 

 To set drop cap go to insert tab. 

 Select the character to Drop Cap 

 Under Text Group Select Drop Cap Option 

 
 

 Find and replace command: Word can search for specific word(s) in a document being 

edited. The main use of this command is to position the cursor at a specific word for the 

purpose of editing. 

Options with Find command: A few options are available while finding text with the find 

command. 

1. Match case: By default, Word does not care about the case of the letters while 

searching for text in the file. If you want to find which matches the exact word, select the 

Match case check box. 

2. Whole words: By default, word looks for the search text inside other words. If you 

do not want it to look inside other words, select Find Whole Words Only check box. 
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3. Sounds Like: This check box, when selected can help you to locate word(s) that sound 

similar. For example, if you ask Word to find Geta with the Sounds Like check box selected, 

word will find Geta, Gita as well as Geeta.  

4. Pattern Matching: Pattern matching is like the wildcards used with the DOS 

command. You can use some special characters such as? and * in the search string to 

perform a complex searches. ? stands for any single character and * stands for any number 

of characters. For example if you want to find words starting with 'th', type th* as the find 

what and check the Use wildcards check box. If you want to find words that start with t 

and are of 2 characters only then type 't?' as the find what and check the Use wildcards 

check box. 

5. Search Direction: By default,  word searches for the text in the entire document i.e. 

'ALL' is selected in the box. It searches for the text in the forward (down) direction starting 

from the current position of the cursor. If you know that the text that you are looking for is 

towards the beginning of the document, you can change the search direction to 'UP'. If you 

know that the text that you are looking for is towards the end of the document, you can 

change the search direction to 'DOWN'  

6. Find all word forms: When this check box is checked it will select all the forms of 

the word given in the Find what box. For example, if sing is given in the Find what box, it 

will also find sang, singing, etc in the search. 

Replace command: The replace command is used to find the search string and replace it with 

the specified text. Shortcut key is 
A 

H  

GO TO command: One can move to a specific page in the current document using the GO 

TO command from edit menu. One can also move to a specific line, comment, graphics, etc. 

Shortcut key is F5. To go to the specific page, perform following steps: 

1. Ensure that Page' is selected in the Go To What list box. 

2. Type the desired page number in the Enter page number text box. Word changes the 

prompt of the Next button to Go To. 

3, Click the Go To button or press enter key. 

3. Close the Go to dialog box by clicking on Close button. 

Print Dialog 
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Options to print: 

Word provides a number of options when you print a document. Word does not provide any 

print option when you click the Print button on the Standard toolbar. Open the File menu and 

then select the Print command from the File menu. Alternatively, press Ctrl+P to select the 

Print command. 

By default, Word puts '1' in the Copies box and selects the 'All' radio button in the Page 

Range box. Accordingly, it prints one copy of all pages of the current document. If you want 

to print multiples copies, select or type the desired number of copies in the Copies box. 

Similarly, if you do not want to print all pages, you have three other options: 

1. Select (click) the Current Page button if you want to print only the current page. 

2. Select the Pages radio button and then type the desired page range. For instance, you 

can type 2-5', if you want to print from the second page through page 5. If you want 

to print selected pages, type the page numbers in the text box. For instance, type '2, 5, 

7’ if you want to print page number 2, 5 and 7. If you want to print page numbers 2, 

6, 9, 10 and 11, you can type '2, 6, 9-11' as the page range. 

3. Click the Selection radio button if you want to print the selected text. You can use this 

option when you want to specify text, e.g. a particular paragraph. However, this 

option is enabled only when you select some text prior to using the Print command. 

Therefore, if you plan to print specified text of the document, select the text that you 

want to print prior to selecting the Print command. 

 

By default, Word prints all pages in the selected print range. However, if you want to print 

only the odd-numbered or even-numbered pages, select it from the 'Print' box located at 

the bottom of the Print dialog box 

 

When you want to print multiple copies, you have the option to collate copies.  

When the Collate check box is selected, it print the entire copy of the selected page range; 

then it prints the second copy, and so on. On the other hand, when collate is not checked, it 

prints the specified number of copies of the first page in the print range. Next, it prints the 

required number of copies of the second page, and so on.   

In the top part of the Print dialog box, Word displays the name of the current printer. In case 

you are using the same printer, you can go ahead and print the document. However, if are 

using a printer that is different from the one shown in the Print dialog box, click the Printer 

button and select the printer you are using. 

After you have specified all options, you can click the OK button to print the document, or 

click the Cancel button to cancel the print command. 

Print Preview: 

Click on Print Preview to display each page as it will look when printed. It works under the 

principle of WYSIWYG i.e. What You See Is What You Get. Basically it gives bird's eyes 

view of the current document. You can select this command from the File menu bar or 

directly click on print preview icon of standard toolbar. 
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What is Mail Merge? 

Mail Merge is a very useful and powerful feature of Word. Mail Merge is used to print 

personalized form letters, envelopes, mailing labels, etc.  

Concept of Mail Merge: 

• In Mail Merge we have to use two files.  

• The first file contains the complete text of the 'letter except the name and address 

of the person. This file is called the main document or the master document.  

• Another file that is called the data file or the data source is used to store name and 

address of persons whom the letters are to be sent.  

• Mail Merge uses the main document and then picks up the first address from the 

data file to print the first letter. Then it picks up the next address from the data file 

to print the second letter, and so on.  

• Thus to use Mail Merge, we have to create two documents — a main document 

and a data source. 

Creation of Mail Merge: 

1. Select Mailing ribbon. 

2. Click on Start mail merge. 

3. Select letter option from that. 

4. Click on select recipient list. 

5. Click the Select Recipients button. 

6. A menu drops down with these options: 

i Type New List: Select this option to build a new list, as in this example. 

ii Use Existing List: Select this option if you already have a database list. 

After choosing the list from the Select Data Source dialog box, skip to 

"Word 2007 Mail Merge — Step 4: Inserting Fields into the Main 

Document." 

7. Choose Type New List. 

8. First, you need to customize the fields shown in this dialog box, by eliminating what 

you don't need and adding what you do need. 

9. Click the Customize Columns button. 

 

State 

ZIP code 

Country ot Region 

Home Phone 

Work Phone 

E-mail Address 
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10. If the list meets your needs, click OK and go to "Word 2007 Mail Merge — Step 3: 

Building Records." If not, continue to the next step here. 

11. Click a field that you do not need. 

12. Click Delete. 

13. Click yes in the confirmation dialog box. 

14. Repeat Steps 5 through 7 for each field you don't need.  

15. To add a field, click Add. 

 

16. Type the field name and click OK. 

 Name the field to reflect the kind of information it contains. 

 No two fields can have the same name. 

 Field names can contain spaces, but cannot start with a space. 

 Field names can be quite long, though shorter is best. 

 The following characters are forbidden in a field name:!  

17. Repeat Steps 9 and 10 for each new field you need in your main document. 

18. When you're done, click OK. 
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19. Save dialog box will option give proper name and click on save button. 

20. At whatever place you want mail merge fields, put cursor there and click on Insert 

merge field option from mailings ribbon. 

21. If you want to check result then click on preview result option or directly click on 

Finish mail merge option, Within select Edit individual document option from that. 

22. After selecting above option merge new document dialog box will open. Select "All" 

option. New file will open having "Letters 1" default name. 

23. Click on office button and Save. Give different name and click on save button. 

 

Advantages of Mail Merge: 

The advantages of Mail Merge are as follows: 

1. The complete text is written only once in main document. Hence it saves time and energy 

and memory. 

2. You can modify the data source whenever needed. 

3. One can merge all records and also some selected records from the data source and print 

the letters for those particular records only. 

 

Auto Text 

AutoText is an easy way to speed up document creation in Microsoft Word. It allows you to 

automatically insert predefined text in your documents, such as datelines, salutations, and 

more. 

You first have to add the AutoText button to the Quick Access Toolbar located at the top 

left of the Word window. 

1. Click the pull-down arrow at the end of the Quick Access Toolbar in the top left of 

the Word window. 

2. Click More Commands. 

3. Click the dropdown list labelled Choose commands from and select Commands Not 

in the Ribbon. 

4. Scroll down in the list and select AutoText. 

5. Click Add>> to move AutoText into the right pane. 

6. Click OK. 

Now click the AutoText button in the Quick Access Toolbar for a list of predefined 

AutoText entries. 

Defining Your Own AutoText Entries 

You can also add your own AutoText entries to your Word templates. 

1. Select the text you want to add to your AutoText gallery. 

2. Click the AutoText button you added to the Quick Access Toolbar (see instructions 

above). 

3. Click Save Selection to AutoText Gallery at the bottom of the AutoTextmenu. 

4. Complete the fields in the Create New Building Block dialog box. 

https://www.thoughtco.com/microsoft-word-shortcuts-and-commands-1856936
https://www.lifewire.com/create-and-use-word-templates-3539889
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5. Click OK. 

What is an AutoCorrect? 

1. You can use the AutoCorrect feature to automatically detect and correct typos, 

misspelled words, grammatical errors, and incorrect capitalization. For example, if 

you type teh plus a space, then AutoCorrect replaces what you have typed with 

"the." You can also use AutoCorrect to quickly insert text, graphics, or symbols. 

For example, type (c) to insert O, or type ac to insert "Acme Corporation." 

2. The AutoCorrect dialog box contains the few options as given below: 

3. Correct Two Initial Capitals: if you type ant word with two initial capital letters, it 

converts it in to a single capital letter. e.g. (Mohan to Mohan). 

4. Capitalize First Letter of Sentence: it is used to automatically capitalize the first 

letter of each sentence. Capitalize Names of Days: it capitalizes the first letter of 

names of days. e.g. 'Monday' to 'Monday'.  

5. Correct the accidental usage of cAPS LOCK key: if you accidentally type a word in 

TITLE Case with the CPAS LOCK key turned on, correct the capitalization of the 

word you typed and turns off t Caps Lock Key. e.g. changes form 
C 

hAPPY' to 

'Happy'. 

6. It can also be used to quickly enter the phrases or names that you commonly use in 

your documents. e.g. you may be using phrase such as 'as soon as possible', 'with 

best wishes' etc. if you give the entry in AutoCorrect as 'asap'. In this case as you 

just type the 'asap' in your document Word automatically convert it into as soon as 

possible. You can insert this AutoCorrect entry using Replace & With option. 

Spelling Checker 

Using the Keyboard Shortcut:  

If you need, just press F7 to call Spelling and Grammar function. 

 

If you want to locate its position on ribbon, please see following content. 

Click Review tab > Proofing group > Spelling and Grammar. 
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 What is a table? 

1. A table is made up of rows and columns of cells that you can fill with text and 

graphics.  

2. Tables are often used to organize and present information, but they have a variety of 

other uses as well. 

3. You can use tables to align numbers in columns, and then sort and perform 

calculations on them. You can also use tables to create attractive page layouts and 

arrange text and graphics.  

4. To sort the data of table you can use sort command from the table menu bar after 

selecting the data of table to which you want to sort. 

 

 

 In order to create a Table, go to the Insert Ribbon and click on Table. 

 

 

 Then go to Insert Table. You will then get a dialog box like this: 

 Your table will appear as below. 

 

1. The cross in the box in the upper left corner allows you to move your table. 

2. The line with the arrow facing opposite directions allows you to either expand or 

shrink your tables. You can then enter the information just like you would an Excel 

sheet. 

3. To move from cell to cell, hit the TAB button.  

 

 To delete the column of the table: 

1. Select the column that you want to delete by clicking its top gridline or top border. 
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2. Under Layout Ribbon, click the Rows & Columns group, click Delete, and then click 

Delete Columns. 

 To delete the row of the table: 

1. Select the row that you want to delete by clicking its left gridline or left border. 

2. Under Layout Ribbon, click the Rows & Columns group, click Delete, and then click 

Delete Rows. 

 

What is a symbol? 

A symbol is a special character(s) that you can insert in a document. e.g. O, , @, etc. 

How to insert a special character? 

1. Click where you want to insert the character. 

2. On the Insert ribbon, click Symbol, and then select symbol or go to More Symbols 

tab. 

Insert Pictures 

Pictures and clip art can be inserted or copied into a document from a file where you save 

pictures. One can also change how a picture or clip art is positioned with text within a 

document. 

Insert clip art 

1. On the Insert tab, in the Illustrations group, click Clip Art. 

2. In the Clip Art task pane, in the Search for text box, type a word or phrase that 

describes the clip art that you want, or type in all or some of the file name of the clip 

art. 

3. Click Go. 

4. In the list of results, click the clip art to insert it. 

Insert a picture from a file 

1. Click where you want to insert the picture. 

2. On the Insert tab, in the Illustrations group, click Picture. 

 

3. Locate the picture that you want to insert. 

4. Double-click the picture that you want to insert. 

Change an inline picture to a floating picture 

1. If the picture is not on a drawing canvas (drawing canvas: An area on which you 

can draw multiple shapes. Because the shapes are contained within the drawing 

canvas, they can be moved and resized as a unit), select the picture. If the picture is 

on a drawing canvas, select the canvas. 

2. Under Picture Tools, on the Format tab, in the Arrange group, click Position. 
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If you don't see Position, click Arrange, and then click Position. 

3. Do one of the following: 

a To change an inline (inline object: A graphic or other object that is 

positioned directly in the text of a Microsoft Word document at the 

insertion point.) picture to a floating (floating object: A graphic or other 

object that is inserted in the drawing layer so that you can position it 

precisely on the page or in front of or behind text or other objects.) 

picture, select the wrapping style that you want. 

b To change a floating picture to an inline picture, select In Line with Text 

(Normal). 

Add WordArt 

WordArt is a gallery of text styles that you can add to your 2007 Microsoft Office system 

documents to create decorative effects, such as shadowed or mirrored (reflected) text. 

1. On the Insert tab, in the Text group, click WordArt, and then click the WordArt style 

that you want.  

2. Enter your text. 

Note: You can customize the shape surrounding the WordArt as well as the text in the 

WordArt 
 

How to insert the current date and time? 

1. Click where you want to insert the date or time. 

2. On the Insert ribbon, click Date and Time. 

3. If you want to insert the date or time in a different language format, then click the 

language in the Language box. 

The Language box includes a list of the enabled editing languages. Additional date and 

time options may also be available, depending on the language that you selected. For 

Help on an option, click the question mark and then click the option. 

4. In the Available formats box, click a date or time format. 

5. Do one of the following: 

o To insert the date and time as a field that's automatically updated when you open or 

print the document, select the Update automatically check box. 

o To maintain the original date and time as static text, clear the Update automatically 

check box. 

How to insert a manual line break? 

1. Click where you want to break a line. 
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2. Press SHIFT+ENTER. 

How to insert a text-wrapping break? 

1. Click where you want to break a line of wrapped text. 

2. On the Insert ribbon, click Break. 

3. Under Break types, click Text wrapping break. 

 

 

Disclaimer: The study material is compiled by Mr. Premal Soni.The basic objective 

of this material is to supplement teaching and discussion in the classroom in the 

subject. Students are required to go for extra reading in the subject through Library 

books recommended by Sardar Patel University, Vallabh Vidyanagar. Students should 

also consult the subject teacher for the solution of their problems in order to enhance 

their subject knowledge. 

 

QUESTION BANK 

Short Questions: 

1. Explain the cut, copy and paste operation. 

2. Explain the page set up dialog box. 

3. Explain the Find, Replace & Go to Operations. 

4. What is WORD Processing? 

5. Explain Font dialog box. 

6. What is Mail Merge? 

7. What is Gutter Margin? 

8. What is Header-Footer? 

9. What is a Data Source in Mail Merge?  

10. What is Drop Cap effect? 

Long Questions: 

1. What is word processing? Write the advantage of word processing. 

2. What is WORD? Write down the features of word processor. 

3. What is Mail Merge? Explain each step in detail. 

4. What is Header-Footer in MS Word? Explain in detail how to add them in a 

document.  

5. Explain Page Setup Dialog Box MS Word.  

6. Explain how to create chart in MS Word. 

7. Explain Find and Replace Dialog Box of MS Word. 

8. Explain spell and grammar check in MS Word. 

9. Explain Table creation feature of MS Word. 


